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Introduction

Thank you for using RazzmaTag, and thank you for reading these instructions! They will help you immensely as you use the program, which is complex but powerful.

RazzmaTag is a universal tagging utility that finds formatting in Microsoft Word and marks it with typesetting tags for use in such programs as QuarkXPress, Ventura, PageMaker, TeX, or pretty much anything else. As an extremely simple example, RazzmaTag can find text in italics and mark it with italic tags, like this: <I>italics<I>.  RazzmaTag can also do the reverse, finding tags and changing them to formatting in Microsoft Word, so if you have old proprietary typesetting files, you can now convert them to Microsoft Word documents. RazzmaTag can also find and tag special characters. For example, you could have it find em dashes—like these—and replace them with tags{M}like these{M}or whatever you need. RazzmaTag can do all of this in a single document, all open documents, or all documents in a folder.

Please note that in order to use RazzmaTag to tag a Word document for use in a typesetting (or other) program, you must first know the tags that your typesetting program uses. Since RazzmaTag is a universal tagger, it doesn’t know what tags you need, so you have to tell it. The documentation that came with your typesetting software should provide a list of all the tags you can use. In QuarkXPress, these are called XPress Tags. In PageMaker, they’re called PageMaker Tags. In Ventura, they’re just called tags. 

I strongly recommend that you try RazzmaTag several times on a variety of test documents until you understand fully how it works and what it can do. I also insist that you back up your documents before using RazzmaTag at any time. Then you’ll have something to go back to if you’re not satisfied with the results. For important information on this topic, please see the section titled “How Would You Like to Save Your Documents?” below.

By using RazzmaTag, you agree to the Terms of Agreement found at the end of this document.

Macros and Templates

RazzmaTag is a collection of macros in a template (named RazzmaTag.dot). You don’t use this template as you would an ordinary template by attaching it to a document. If you try to do that, you’ll run into problems. Instead, you “add” it to Microsoft Word as a global template or add-in (see installation instructions below).

Because the template contains macros, some virus-checking programs or even Word itself may warn you that the template could contain Word viruses. Please rest assured that it does not. Our macros have been carefully checked and tested to make sure they are safe and usable. To ensure your security, you should download the program directly from our Web site at www.editorium.com.

Please do not rename any of the RazzmaTag macros, copy them to another template, or remove them from the RazzmaTag template. RazzmaTag uses these macros in combination and will not work properly if they have been copied to another template or renamed, or if some of the macros are no longer present.

Installing RazzmaTag
To install the program:

1. Unzip (or unstuff) the program files so that they’re all together in a single folder or on your desktop. (If you need software to unzip or unstuff the program, you can download it from www.winzip.com or www.aladdinsys.com.) You cannot install the program by just opening the zip file and double-clicking one of the files.
2. After the files are unzipped, open the file named “Install RazzmaTag.dot” in Microsoft Word by clicking File > Open, selecting the file, and clicking the Open button. Do not open the file by double-clicking it outside of Microsoft Word. If you do, you’ll run into problems later.

3. If Word asks if you want to “enable macros” when opening the file, your answer should be yes. Otherwise, the program won’t work. If Word tells you that the macros have been disabled, you’ll need to change your macro security settings and then restart Word before installing. Please see the “Troubleshooting” section at the end of this document for more information.

4. Double-click the large button that says “Double-Click here to Install.” This will install RazzmaTag as a global template or add-in, which simply means that the program will be saved to Word’s Startup folder and will thus be available any time you start Word.

5. Restart Word to activate the program and display the RazzmaTag menu at the top of your Word window. In Word 2007, the menu will be displayed under Word’s “Add-ins” menu.
If that doesn’t  work, you can install the program manually. With Microsoft Word closed:

1.
On your computer desktop, double-click My Computer. (On a Macintosh, open your hard drive. Then continue with step 5, below.)

2.
At the top of the window that opens, you’ll see a “Tools” menu. Click that, and then click “Folder Options.”

3.
Click the “View” tab and make sure that “Show hidden files and folders” is selected. Then click the OK button.

4.
Back in the window for “My Computer,” double-click your local hard drive, probably “C.”

5.
Open the folders named, consecutively within each other, Documents and Settings > [your name] > Application Data > Microsoft > Word > Startup. (On a Macintosh, open Applications > Microsoft Office > Office > Startup > Word.)

6.
Put the file named “RazzmaTag.dot” into the Startup folder (on a Macintosh, into the Startup > Word folder).

7.
Restart Microsoft Word.

Uninstalling RazzmaTag
To uninstall the program:

1. Open the file named “Install RazzmaTag.dot” in Microsoft Word by clicking File > Open, selecting the template, and clicking the Open button. Do not open the file by double-clicking it outside of Microsoft Word. If you do, you’ll run into problems later.

2. If Word asks if you want to “enable macros” when opening the file, your answer should be yes. Otherwise, the program won’t work. If Word tells you that the macros have been disabled, you’ll need to change your macro security settings in order to use the program. Please see the “Troubleshooting” section of this documentation for more information.

3. Double-click the large button that says “Double-Click here to Uninstall.”

If necessary, you can remove the template manually from Word’s Startup folder:

1.
On your computer desktop, double-click My Computer. (On a Macintosh, open your hard drive. Then continue with step 5, below.)
2.
At the top of the window that opens, you’ll see a “Tools” menu. Click that, and then click “Folder Options.”
3.
Click the “View” tab and make sure that “Show hidden files and folders” is selected. Then click the OK button.

4.
Back in the window for “My Computer,” double-click your local hard drive, probably “C.”
5.
Open the folders named, consecutively within each other, Documents and Settings > [your name] > Application Data > Microsoft > Word > Startup. (On a Macintosh, open Applications > Microsoft Office > Office > Startup > Word.)
6.
Remove the file named “RazzmaTag.dot.”
7.
Restart Microsoft Word.

Tagging Formatting

Before using RazzmaTag, you’ll need to prepare a “master list” that tells RazzmaTag what formatting or characters to find and how to tag them. For example, let's say you want to import a document into QuarkXPress. Before you can do so, your document will need style-sheet tags at the beginning of paragraphs, and it will need inline tags to indicate character styles (such as Footnote Reference) and character formatting (such as italic and bold). Here's a theoretical sample of your text before you run it through RazzmaTag:

Lorem Ipsum Dolor

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Even in this short sample, there’s a lot going on: The large title (“Lorem Ipsum Dolor”) is styled with paragraph style Heading 3, and the body text below it is styled with paragraph style Body. A bold character style named Emphasis is applied to “dolor,” and “consectetuer” is formatted with italic. To be imported into QuarkXPress, the sample would need to be tagged like this:

@Heading 3:Lorem ipsum dolor

@Body:Lorem ipsum <@Emphasis>dolor <@$p>sit amet, <I>consectetuer<I> adipiscing elit.

You'll notice that Word's Heading 3 style has been tagged with @Heading 3: and that body text has been tagged with @Body:. The Emphasis character style has been set off with <@Emphasis> and <@$p>. In addition, the italic character formatting has been set off by italic tags, <I>. (The documentation that came with your typesetting software should provide a list of all the tags you can use. In QuarkXPress, these are called XPress Tags. In PageMaker, they’re called PageMaker Tags. In Ventura, they’re just called tags.)

To insert these tags with RazzmaTag, you'd put the following entries on your master find-and-replace list (which is simply an otherwise-empty Word document):

Heading 3|@Heading 3:^&+P

Body|@Body:^&+P

Emphasis|<@Emphasis>^&<@$p>+A

it|<I>^&<I>+F

(You must be absolutely accurate in typing the entries, and you must make sure the entries are the only things in the document. Don’t include a document title, explanations, comments, or anything else. The entries can be the same length as a regular Word find or replace string: from 1 to 255 characters. You can have from 1 to 8,142 entries.)

Let's look at those lines one at a time.

Tagging a Paragraph Style

The first line starts with Heading 3, which tells RazzmaTag the name of the style to find.

Next comes the pipe symbol (|), which separates the Find and Replace entries. You’ll find this symbol on a key near your Backspace key.

After that comes the Quark XPress Tag for the Quark style sheet, @Heading 3:

That’s followed by the “Find What Text” code, ^&, which tells Word to insert the text it found formatted with the Heading 3 style. Be sure to include this; if you don’t, Word will replace the Heading 3 text with nothing.

Finally, there’s a plus sign (+), which tells RazzmaTag you’re adding a code to tell it what to do, and the code itself, a capital P, which tells RazzmaTag to look for paragraph style formatting. Each entry (including the last) must end with a carriage return.

The second line, which tags Body style, follows the same pattern as the first, so we won’t analyze it here.

Tagging a Character Style

Now let’s look at the third line:

Emphasis|<@Emphasis>^&<@$p>+A

Emphasis is the name of the character style to find.

It’s followed by a pipe symbol to separate the Find and Replace entries.

Next comes <@Emphasis>, the starting tag for a character style named Emphasis in QuarkXPress.

That’s followed by the “Find What Text” code, ^&, again to tell Word you want to include the text it finds formatted with the Emphasis character style.

After that is <@$p>, the ending tag for a character style in QuarkXPress.

Finally, we have a plus sign and the RazzmaTag code for tagging character style formatting, which is a capital A. And, of course, the entry ends with a carriage return.

Tagging Character Formatting

The fourth line works in a similar way:

it|<I>^&<I>+F

The “it” is a RazzmaTag code that specifies italic.

It’s followed by a pipe symbol to separate the Find and Replace entries.

Next comes a QuarkXPress tag for italic, <I>.

That’s followed by the “Find What Text” code, ^&, again to tell Word you want to include the italicized text it finds.

After that, there’s another <I> to tell Quark to stop with the italic already. (You could also use <$>.)

Finally, we have a plus sign and the code for tagging character formatting, which is a capital F. And again, there’s a carriage return.

And that’s how it’s done.

Here are the RazzmaTag codes that signify the various kinds of character formatting you can look for and tag:

Bold = bo

Italic = it 

Bold and italic = bi

Underline = ul

Strikethrough = st

Superscript = ss

Subscript = sb

Small caps = sc

All caps = ac

And here is a summary of the RazzmaTag codes that specify whether to tag paragraph style formatting, character style formatting, or directly applied character formatting:

+P = paragraph style formatting

+A = character style formatting

+F = character formatting (such as bold or italic)

Tagging Font, Point Size, and Paragraph Formatting

In addition to bold, italic, small caps, and so on, you can find and tag certain other kinds of character formatting as well:

1. Font.

2. Point size.

3. Paragraph format (Left, Right, Center, Justified).

To tag this kind of formatting, the entry on your master list should take the following form, with its parts separated by the tilde character (which is on the upper left of most keyboards):

Font~point size~paragraph format~character format|<tag>^&<maybe a closing tag>+F

For example, you could tag text in Baskerville 16-point centered italic like this:

Baskerville~16~C~it|<Heading 2>^&+F

Let’s look at each part of that entry.

The font here is Baskerville, and you must enter its name exactly as it appears in Word’s Font dialog (Format > Font > Font). If the font name is something odd like “Kuenst480 Blk BT,” then that’s the name you’ll need to use. If you don’t want to specify a font (you want to find any font), enter “(normal text)”—including the parentheses but not the quotation marks.

Next comes a tilde to separate the font name from the point size.

That’s followed by the point size, 16, and again, you can use any point size Word can accept in the Font dialog. If you don’t want to specify a point size (you want to find any point size), enter “A” (without the quotation marks) at this position in your entry.

Next comes a tilde to separate the point size from the paragraph format.

The paragraph format here is designated by “C” for “Center.” You can specify the following kinds of paragraph formatting:

1. Left = L

2. Right = R

3. Center = C

4. Justified = J

5. Any of the above = A

Next we have the code “it” to specify italic. As before, the codes you can use are:

Bold = bo

Italic = it 

Bold and italic = bi

Underline = ul

Strikethrough = st

Superscript = ss

Subscript = sb

Small caps = sc

All caps = ac

There’s also one additional code:

Any formatting = af

You should use this code if you don’t want to specify italic, bold, or other character formatting but want to find any kind of character formatting, including italic, bold, or just regular text. You cannot use this code if you’re tagging character formatting alone. For example, this entry will not work because you’ve given Word nothing specific to look for:

af|<Regular>^&<\Regular>+F

Finally, when finding font, point size, and paragraph format, you can specify formatting that is not bold, not italic, and so on, with these codes:

Not bold = -bo

Not italic = -it 

Not bold and italic = -bi

Not underline = -ul

Not strikethrough = -st

Not superscript = -ss

Not subscript = -sb

Not small caps = -sc

Not all caps = -ac

Not any formatting (not bold, not italic—not any of the above; in other words, regular text only) = -af

Note the addition of a hyphen in front of the codes to mean “not.” Sorry, but you cannot use these codes if you’re tagging character formatting alone. For example, this entry will not work:

-sc|<NotSmallCaps>^&<\NotSmallCaps>+F

It also doesn’t make sense, which is why it’s not allowed.

Now back to our example, which is:

Baskerville~16~C~it|<Heading 2>^&+F

After the “Find” part of the entry comes the pipe symbol to separate our Find from our Replace.

Then comes an arbitrary (in this case) tag for Heading 2.

That’s followed by the “Find What Text” wildcard, ^&, so we’ll replace the text we find with itself after our tag.

Finally, we have the code that tells RazzmaTag to search for character formatting, +F.

Please note that you have to specify all of the items: font, point size, paragraph format, and character format. You can’t leave any of them out. For example, this entry will not work (it will be skipped) because the point size is missing:

Baskerville~C~it|<Heading 2>^&+F

This entry, which tells RazzmaTag not to search for a particular point size, will work:

Baskerville~A~C~it|<Heading 2>^&+F

Here’s an entry that searches for nothing in particular (and thus finds nothing), just for the purpose of illustration:

(normal text)~A~A~af|<NoTags>^&<\NoTags>+F

The ability to tag directly applied formatting may be RazzmaTag’s finest feature, because once that formatting is tagged, you can turn around and use RazzmaTag to turn those tags into styles! If you’ve done much editing or formatting of documents, you probably understand how important that is.

Order of List Entries

You control the way tags are applied by adjusting two things:

1. The order of your list entries.

2. The formatting of your styles.

For example, let’s say that your Heading 1 paragraph style is defined as using bold formatting. If you put your list entries in this order—

bo|<B>^&<B>+F

Heading 1|@Heading 1:^&+P

—your tagged text will look like this:

<B>@Heading1:Here’s My Heading.<B>

That’s probably not what you want. But if you put your list entries in this order—

Heading 1|@Heading 1:^&+P

bo|<B>^&<B>+F

—then your tagged text will look like this:

@Heading1:Here’s My Heading.

This is true because RazzmaTag removes the specified formatting (paragraph style, character style, or character formatting) as it goes. (When tagging directly applied formatting, RazzmaTag sets the font to Times [on Macintosh] or Times New Roman [on PC], point size to 12, and alignment to Left.) So after RazzmaTagg tags your bold heading as a paragraph style, the heading will no longer be bold, which means that the next list entry won’t see it as bold and won’t enclose it with <B> tags.

You could also keep your Heading 1 style from being enclosed with <B> tags simply by making sure it’s not defined as being bold to begin with. In fact, let’s say that you’ve done that, and you have a heading that looks like this:

Here’s My Heading

Notice that the word “My” has been directly formatted with bold. Even if your list is in this order—

Heading 1|@Heading 1:^&+P

bo|<B>^&<B>+F

—your tagged text will look like this:

@Heading1:Here’s <B>My<B> Heading

Why? Because when RazzmaTag tags and removes the Heading 1 style, the bold formatting remains intact, just as it does if you remove the Heading 1 style manually. So, RazzmaTag is able to tag it.

Character Formatting over Character Styles

However, the fact that RazzmaTag removes formatting as it goes means that any formatting (such as italic or bold) applied over the top of a character style (not a paragraph style) will be removed if your list entries are in this order:

1. Character style.

2. Directly applied formatting (such as italic or bold).

That’s because Word has no way to remove the character style (from the selected text) without also removing directly applied formatting. For example, let’s say that you have italic formatting applied to some words that are otherwise formatted with a character style named “Heavy,” like this:

This is some document text with italic applied to a word formatted with a character style named “Heavy.”

Let’s also say that your master list includes two entries, in this order:

Heavy|<@Heavy>^&<@$p>+A

it|<I>^&<I>+F

Using your list, RazzmaTag will tag your text like this:

This is <@Heavy>some document text <@$p>with italic applied to a word formatted with a character style named “Heavy.”

Notice that the italicized word was not tagged, because RazzmaTag removed directly applied formatting from your text when it tagged the character style. So, if you need to tag directly applied formatting on top of a character style, you should tag the directly applied formatting first, like this:

it|<I>^&<I>+f

Heavy|<@Heavy>^&<@$p>+A

This is possible because Word does have a way to remove directly applied formatting without removing the character style. Hooray! So, the best order for tagging all kinds of formatting is probably this one:

1. Paragraph styles.

2. Directly applied formatting, such as bold and italic.

3. Character styles.

For example:

Heading 2|@Heading 2:^&+P

it|<I>^&<I>+F

Heavy|<@Heavy>^&<@$p>+A

Of course, that also means that if your character style is defined as italic, you’ll get <I> tags on either side of the text formatted with the character style. So, you really have to think things through to get the tagging you want. I’d actually recommend not using directly applied formatting at all. Instead, use character styles defined and named as italic, bold, or whatever else you need. Another approach is not to use character styles at all. But to reiterate, you can control the way tags are applied by two things:

1. The order of your list entries.

2. The formatting of your styles.

Directly Applied Formatting

As mentioned above, if you tag directly applied formatting, such as font, point size, or paragraph format, RazzmaTag “removes” the formatting as it goes by setting the font to Times (on Macintosh) or Times New Roman (on PC), the point size to 12, and the paragraph format to Left. (After all, it can’t set them to nothing.) So, if you want to tag left-aligned 12-point Times New Roman (on PC) or Times (on Macintosh), you should do so before tagging any other directly applied formatting, because other formatting will become left-aligned 12-point Times New Roman (or Times) after it’s tagged.

Saving Your Files

If you’re tagging documents, you should tell RazzmaTag to save them as text files. For truly important information about this, please see the section titled “How Would You Like to Save Your Documents?” below.

Untagging Formatting

Now let’s say you’ve got a bunch of tagged text that you want to untag, turning the tags into formatting. The text you want to untag looks like this:

@Heading 3:Lorem ipsum dolor

@Body:Lorem ipsum <@Emphasis>dolor <@$p>sit amet, <I>consectetuer<I> adipiscing elit.

To continue with our previous example, you’d use these lines in your RazzmaTag master list:

\@Heading 3:(*)|Heading 3+p

\@Body:(*)|Body+p

\<\@Emphasis\>(*)\<\@\$p\>|Emphasis+a

\<I\>(*)\<I\>|it+f

That looks complicated, but to simplify it would mean limiting the program’s ability to turn any tags into formatting. I’ve opted to let you use RazzmaTag with the full power of Word’s wildcard searching. So you can fully understand the rest of this explanation, please read the document called “Advanced Searching in Microsoft Word,” which is included with your RazzmaTag files. It’s worth the effort, believe me.

Now, let’s dissect those lines.

Untagging a Paragraph Style

Here’s the first line:

\@Heading 3:(*)|Heading 3+p

The initial backslash (\) tells Word that you want to use the @ sign as a character rather than a wildcard (wildcard searching is automatically turned on when you use the +p code at the end of a master-list entry). That’s necessary since here the @ is part of the Quark tag. (Ordinarily in a wildcard search, @ means “any number of the previous character or group of characters.”)

Next comes the tag to convert, @Heading 3:

After that comes a wildcard group, (*). The parentheses “group” the enclosed wildcard so that RazzmaTag can tell Word to use any text the wildcard finds as the Replace string. (RazzmaTag automatically does this with the “Find What Expression” wildcard, \1, although you won’t actually see this wildcard in your master list. So, you can use only one wildcard group per line in your master list, but that should be enough for both undelimited tags [such as @Heading 3:] and delimited tags [such as <I>(your text)<I>] Paragraph styles don’t have to have ending tags because they format one paragraph at a time). The interesting thing in this example is that the * wildcard tells Word to find zero or more characters after the \@Heading 3: code. Since we haven’t provided an ending delimiter code (paragraph styles don’t need them), that’s exactly what it will find—zero characters. And that’s what the \@Heading 3: code will be replaced with—zero characters. In other words, it will be deleted, which is exactly what we want.

Next comes the pipe symbol (|) to separate the Find and Replace entries.

After that comes Heading 3, the name of the style to apply to the tags that are found.

Finally, there’s a +p, which tells RazzmaTag to replace tags with a paragraph style.

Please note that if you’re untagging a text file, custom paragraph styles won’t even exist in the document. In that case, RazzmaTag will create the styles for you, formatted in red so you can easily spot text formatted with those styles. Then you can modify the styles or apply a different template to the document (being sure to update styles) so the formatting will look the way you want it to.

The second line in our example follows the same pattern as the first, so we won’t discuss it.

Untagging a Character Style

Now let’s look at the third line:

\<\@Emphasis\>(*)\<\@\$p\>|Emphasis+a

Again, the backslashes tell Word that characters following them are to be used not as wildcards but as characters. Once you understand that, the codes are more understandable.

So, first we have \<\@Emphasis\>, which will find our starting tag of <@Emphasis>.

After that is a parenthetical wildcard group of an asterisk, (*), which tells Word to find zero or more characters until it comes to the final tag, <@$p>. (Note that character styles need both beginning and ending tags.) Again, RazzmaTag will tell Word to use any text the grouped wildcard finds as the Replace string. (RazzmaTag automatically does this with the “Find What Expression” wildcard, \1, although you won’t actually see this wildcard in your master list.)

Next is <\@\$p\>, which will find our ending Quark tag of <@$p>.

That’s followed by the pipe symbol, which separates the Find and Replace strings.

After that comes Emphasis, which tells RazzmaTag to use the Emphasis character style to format the text that is found.

Finally, there’s the +a code, which tells RazzmaTag to format the text with a character style.

Please note that if you’re untagging a text file, custom character styles won’t even exist in the document. In that case, RazzmaTag will create the styles for you, formatted in blue so you can easily spot text formatted with those styles. Then you can modify the styles or apply a different template to the document (being sure to update styles) so the formatting will look the way you want it to.

Untagging Character Formatting

And now for the fourth and last line:

\<I\>(*)\<I\>|it+f

First we have \<I\>, which will find our Quark italic tag of <I>.

Next is a parenthetical wildcard group of an asterisk, (*), which tells Word to find any string of characters until it comes to the final italic tag. (Note that character formatting needs both beginning and ending tags.) Again, RazzmaTag will tell Word to use any text the grouped wildcard finds as the Replace string.

The final italic tag is represented by \<I\>.

After that is the pipe symbol, which separates the Find and Replace strings.

Next is the “it” code, which tells RazzmaTag to use italic to format the text that is found.

Finally, there’s the +f code, which tells RazzmaTag to format the text with character formatting rather than a style. Wildcard searching is automatically turned on when you use the +f code at the end of a master-list entry.

Here are the RazzmaTag codes that signify the various kinds of character formatting you can apply to the tagged text.

Bold = bo

Italic = it 

Bold and italic = bi

Underline = ul

Strikethrough = st

Superscript = ss

Subscript = sb

Small caps = sc

All caps = ac

And again, here are the RazzmaTag codes that specify whether to format tags with style or character formatting:

+p = paragraph style formatting

+a = character style formatting

+f = character formatting (such as bold or italic)

If you have questions about whether your master-list entry strings (such as \<I\>(*)\<I\>) will work, try them manually in Word’s Replace dialog (with “Use Wildcards” turned on; you may need to click the “More” button before this is available) before using them in RazzmaTag. If they won’t work there, they won’t work in RazzmaTag, either. When doing such a test, be sure you don’t include any codes specific to RazzmaTag, such as “it” or “+p,” as Word alone won’t recognize them.

No Untagging of Font, Point Size, or Paragraph Format

Please note that you cannot untag such character formatting as font, point size, and character format. Why? Because these should be defined in styles rather than applied directly to your text. RazzmaTag allows you to turn direct formatting into tags and then into styles, but it won’t let you go the other direction. For example, an entry like this will not work:

\<Heading 2\>(*)|Baskerville~16~C~it+f

Saving Your Documents

If you’re untagging files, you should tell RazzmaTag to save them as Word documents. For truly important information about this, please see the section titled “How Would You Like to Save Your Documents?” below.

Two Cautions

There are two cautions I’d like to give you here.

1. Use Well-Formed Tags and List Entries

The first caution is to be careful in the kinds of tags you use and how your master-list entries are formed. Consider this example:

<@Heavy:<B>This is a test<B>>

Here we have tags for a character style on either side of some text:

Beginning tag: <@Heavy:

Ending tag: >

Notice that we’ve used only a closing angle bracket as the closing delimiter.

We also have tags for some bold formatting.

Now, if you create a master-list entry that looks like this—

\<\@Heavy:\>(*)\>|Heavy+a

—hoping to get that ending > delimiter, you’ll be in trouble, because what it will find is the closing angle bracket on the first <B> tag. It will find this:

<@Heavy:<B>

And that means your formatting isn’t going to turn out right and you’ll be left with extraneous tags in your text. The lesson is, you’re better off to have clearly delimited, unique tags for each kind of formatting and each kind of delimiter. Quark XPress tags, HTML tags, and many other standard tags will work just fine because they follow this rule.

Note that you cannot apply character styles or character formatting to text with a beginning tag but no ending tag (although you can apply paragraph styles). If you try something like this—

\<Heading 3\>(*)|bo+f

—you’ll find run into problems, because Word will simply apply the bold formatting to zero or more characters (*) after the tag. Since it doesn’t know how many more (because there’s no ending tag), it will simply apply it to zero characters, which means you’ll get nothing.

If you start having trouble with stuff like this, slow down. Don’t panic and wildly start trying to fix entries on your list. Instead, try processing your entries one at a time, or better yet, try searching for an entry manually in Microsoft Word so you can see what it’s actually doing. You’ll soon learn what’s causing the problem.

2. Don’t Tag and Untag at the Same Time

The second caution is that you should not ordinarily tag and untag documents from the same master list. For example, a single list should not usually contain two entries like these:

Heading 2|@Heading 2:^&+P

\@Heading 3:(*)|Heading 3+p

If you mix entries like that, you may run into problems. Either tag documents or untag them. Don’t try to do both at the same time.

Well, all right, you can if you really know what you’re doing. Consider this example:

Heading 3|@Switcheroo:^&+P

\@Switcheroo:|Heading 2+p

The first line searches for Heading 3 formatting and tags it with @Switcheroo:. The second line searches for the @Switcheroo: tag and formats it as Heading 2. So the overall effect is to replace Heading 3 formatting with Heading 2 formatting.

This kind of thing may come in handy, so I’ve allowed the program to do it. Ordinarily, however, I don’t recommend it, and if you do it, the program will ask you to confirm the way you are saving your documents (as text or as Word).

Tagging Characters

And now for something I think is quite beautiful: You can use RazzmaTag to insert typesetting tags that represent special characters, even Unicode characters, which means it’s now possible to convert Unicode characters in Word into something useable in QuarkXPress or other typesetting programs. This is a Big Deal because (at least as of the date of this writing) QuarkXPress will not import Unicode characters, even though more and more Word users are using them.

Here’s a simple example of a master list to tag two special characters, an e with an acute accent and a u with an umlaut:

é|<e-acute>

ü|<u-umlaut>

(Of course, the tags should be whatever you need in your production environment.) Please note that we didn’t include a +P, +A, +F, +p, +a, or +f, because these codes tell RazzmaTag to look for formatting or tags. In this case we’re not looking for formatting or tags; we’re just looking for text (characters).

Need to tag Unicode characters? Let’s say you’ve got the Unicode character for the Greek character alpha in your Word document. Let’s also say you you’re using QuarkXPress and have access to a Greek font. How do you convert the Word alpha into a Quark alpha? Like this:

1. In your RazzmaTag master list, include a caret and lowercase u (for Unicode) followed by the Unicode decimal (not hex) character number for alpha:

^u945

2. Insert a pipe symbol to separate your Find and Replace entries.

3. Insert the Quark XPress Tags that indicate a character style (which will use the Greek font) and character that will produce the alpha in QuarkXPress:

<@Greek>a<@$p>

The full master-list entry looks like this:

^u945|<@Greek>a<@$p>

After you run RazzmaTag and bring the file into QuarkXPress, you’ll need to format the character style sheet (in this case, named Greek) with the Greek font, which will display the lowercase a in the Greek character style as an alpha.

You can use this technique to convert any Unicode character in Word into any character in a special font in QuarkXPress—math characters, foreign scripts, whatever. To do so, you have to know two things: (1) the Unicode decimal character number and (2) the character that will produce the special character when formatted with your special font in QuarkXPress.

Here’s a more mundane example that doesn’t involve Unicode. Let’s say you’re working in Word 2000, on a PC, and you want to convert em dashes to the appropriate character for QuarkXPress on a Macintosh. Piece of cake:

^0151|<\#208>

The ^0151 is the code to find an em dash in Microsoft Word. <\#208> is the QuarkXPress code for an em dash on a Macintosh.

Why those numbers? The 0151 is simply the extended ASCII number for an em dash on a PC. The 208 is the extended ASCII number for an em dash on a Macintosh. You can use the code pattern of ^0??? to find any ASCII character in Word, and you can use the code pattern of <\#???> with any character number to specify a character in QuarkXPress. I’ve provided a list of these numbers for special characters on both Mac and PC in an appendix to this document.

For some special Word characters, there’s an easier way. Consider this Find and Replace string:

^+|<\#208>

The ^+ is the code to find an em dash in Microsoft Word. Again, <\#208> is the QuarkXPress tag for an em dash on a Macintosh.

For a list of codes (such as +^) for finding special characters in Microsoft Word, please see the document called “Advanced Searching in Microsoft Word,” which is included with your RazzmaTag files.

You can find lists of Unicode characters in many places on the Internet, but my favorite resource for this purpose is Allan Wood’s Unicode Resources site at http://www.alanwood.net/unicode/.

If you create a RazzmaTag master list for converting Unicode or other special characters and would be willing to share it with others, please email it to me at editor@editorium.com. I’ll be happy to post it on our Web site.

Using Word’s Find Options

When tagging (or replacing) characters or other text (but not formatting), you can use Word’s basic Find options just as you can with Word’s regular Find feature. These options are:

1. Match Case.

2. Find Whole Words Only.

3. Use Pattern Matching (Use Wildcards).

4. Sounds Like.

To use these options, add a plus sign and a code letter (in lowercase) to the end of each find and replace entry. The code letter is the same as the letter used in Word 95’s Find dialog box to select these options:

“c” for Match Case.

“w” for Find Whole Words Only.

“&” for Match Case and Find Whole Words Only at the same time.

“m” for Pattern Matching (Use Wildcards).

“l” for Sounds Like.

You can use only one of these options per entry. Such entries might look like this:

Department|department+c

per|according to+w

p ([0-9]@.\))|p. \1+m

You’ll notice that we’re replacing full words here, and RazzmaTag is fully capable of doing that, or even of replacing longer text strings. However, RazzmaTag doesn’t include the ability to approve each replacement manually, because it’s designed primarily for tagging text. If you need to find and replace lots of text strings and need to approve replacements manually as you go, our MegaReplacer program will do the job.

Please note that because RazzmaTag uses the pipe symbol and the plus sign as delimiters, it cannot find or replace text that includes the pipe symbol or the plus sign. Also, be aware that with RazzmaTag, you can’t use Word’s Find options to do anything you couldn’t ordinarily do when searching manually. For example, using Word’s Find feature manually, you can try searching a document for a carriage return (^p) with “Use Pattern Matching” turned on. If you do, Word will give you an error message. RazzmaTag won’t give you an error message, but it also won’t find the carriage return. In effect, it will simply ignore that find-and-replace entry. Similarly, if you put several words separated by spaces in Word’s “Find What” box, the “Find Whole Words Only” option is unavailable. This is also true with RazzmaTag, even though you can’t see that it is unavailable. If you have any questions about whether a find-and-replace entry will work with a certain option, you should try it manually in Word. If it won’t work that way, it won’t work with RazzmaTag, either.

Running RazzmaTag

To run RazzmaTag, follow this procedure:

1. Back up your documents. Once RazzmaTag has made the changes you’ve specified, it saves the documents with those changes. Depending on which way you’re saving what, that may mean there is no going back. So please, back up your documents so you’ll have something to go back to if you’re not satisfied with the results of your search.

2. Make sure your master list is the active document on your screen.

3. Under the RazzmaTag menu, select RazzmaTag.

The following dialog will be displayed:
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What Documents Would You Like to Use?

You can run RazzmaTag on:

1. The first document after your master list. This is the document that would be active if you closed the list. Be careful to get the right document. Better yet, open only one document besides your list so you don’t accidentally run RazzmaTag on the wrong one.

2. All open documents but your list.

3. All documents in a folder.

If you want to use RazzmaTag on all the documents in a folder, first make sure only the documents you want it to work on are in the folder. Then you won’t inadvertently change, say, some press-ready documents that you have spent many hours editing and formatting. Show all documents (*.*) to be sure. In addition, make sure none of the documents is protected or read only. RazzmaTag runs the selected macro on the documents and then saves them. If the documents are protected or read only, RazzmaTag will not work.

If you would like RazzmaTag to work on all documents in a folder, use the dialog box to carefully select the folder. (Don’t get the wrong one!) Then click “OK.” I recommend using a new folder called “Copy” into which you copy your documents so that your original documents remain intact.

RazzmaTag turns off all automacros while it runs.

How Would You Like to Save Your Documents?

RazzmaTag gives you two ways to save your files, and you should consider these carefully depending on whether you are tagging or untagging files. The two ways are:

1. As text (.txt).

2. As Word documents (.doc).

Saving as Text

If you’re tagging documents, I recommend saving them as text. Doing so removes all formatting, leaving only your tags to indicate what the formatting should be. It also improves your odds of successfully importing the files into a typesetting program. Finally, it leaves your original Word documents in their pristine, formatted, untagged condition. (On rare occasions, however, you may want to save your newly tagged files as Word documents so you can identify obscure formatting you might have left out of your master list.)

WARNING: If you untag documents and then save them as text, not only will all of your formatting be lost, but your tags will be lost as well, since you’ve just untagged the documents. So please, I beg you, back up your files before using RazzmaTag. Then you’ll have something to go back to if you need to do so. The Editorium cannot be held responsible for files that don’t turn out the way you want them to. To help guard against this problem, if you are untagging files and say that you want to save them as text, RazzmaTag will ask you to confirm that this is really your intention.

Please note that you should not usually tag and untag documents on the same master list. If you do, you may run into problems.

Saving as Word Documents

If you’re untagging documents, I recommend saving them as Word documents. Actually, that only makes any sense, because the whole point is to restore formatting to tagged text. If you save them as text files, all of that formatting will be lost. Also, if you’ve just untagged text files, saving them as Word documents will leave your original text files in their pristine, unformatted, tagged condition.

WARNING: If you tag Word documents, saving them as Word documents will overwrite your existing documents. So please, I beg you, back up your files before using RazzmaTag. Then you’ll have something to go back to if you need to do so. The Editorium cannot be held responsible for files that don’t turn out the way you want them to. To help guard against this problem, if you are tagging files and say that you want to save them as Word documents, RazzmaTag will ask you to confirm that this is really your intention.

Please note that you should not usually untag and tag documents on the same master list. If you do, you’ll run into problems.

Finishing Up

After selecting the options you want to use, click the OK button and follow any remaining instructions on your screen. Then wait while RazzmaTag does its work. (NOTE: RazzmaTag will not make replacements in annotations, headers, or footers, but it will make replacements in footnotes and endnotes.) When the program is finished, it will tell you so.

Registering RazzmaTag

If you like RazzmaTag and plan to continue using it, you should purchase a license to do so. If you don’t, your copy of the program is for evaluation purposes only, and it will stop working after 45 days or 150 uses, whichever comes first. After you purchase a license to use the program, we’ll send you a password that will unlock the program to run without limitation on time or use.

The terms of your license prohibit you from giving your program password to someone else or using it on someone else’s computer. However, you may use the password on up to three of your own computers. For example, you could install RazzmaTag and use your password on your computer at work, your computer at home, and your laptop. However, you may run the program on only one of your computers at a time. If you need to run the program on more than one computer at a time (for example, for use by a family member or employee), you must purchase another license and get another password for the program. This is the honest and legal thing to do. Besides that, we’re a small company and need your support. Thanks for your cooperation.

Here are the prices for a program license, but these are subject to change without notice:

1 user: $29.95

2-10 users: $19.95

11-49 users: $18.95

50+ users: $17.95

Getting a Password

Here’s how to purchase a program license so you can get your password:

1. Click the RazzmaTag menu item at the top of your Word window.

2. Click the “Register RazzmaTag” menu item.

You’ll be presented with two options:

1. Get a password for this computer.

2. Enter the password for this computer.

Click option 1, “Get a password for this computer.” Then click “OK.”

You’ll be presented with two more options:

1. Register on the Internet (at www.editorium.com).

2. Register by mail.

Click the option that meets your needs and follow the instructions on your screen. Registering on the Internet offers some distinct advantages:

1. You’ll receive your password automatically by return email as soon as your payment is processed. If you’re paying by credit card, you’ll receive your password almost immediately. Just check your email as soon as your online registration is complete.

2. You can make your payment in several different forms: credit card, check, or money order. If you don’t pay with a credit card, however, you won’t receive your password until after we receive your payment.

3. You can make your payment in several different ways: on our secure online order form, by fax, or over the phone.

If you’re interested in using a purchase order, please let us know by emailing sales@editorium.com.

If you don’t have access to the Internet, you can still register by postal mail. In that case, we’ll send your password by email (if you have it) or postal mail after we receive your check or money order and your registration form. If you’re registering by mail, the program will create a registration form in Microsoft Word. Please fill out the form, using your cursor keys to move from item to item. Then print the form and mail it to the address at the top of the form.

Using Your Password

Once you’ve received your password from the Editorium, you’ll need to enter it into the RazzmaTag program. To do so:

1. Click the “RazzmaTag” menu item at the top of the Word screen.

2. Click the “Register” menu item.

3. Click “Enter the password for this computer.” Then click “OK.”

The password entry box will appear on your screen. Carefully type the password into the box labeled “Enter your password.”

If you have a valid password and type it correctly, the program will tell you that your registration was successful. After that, the program will run without limitation on time or use.

Thanks for your support!

Troubleshooting

Problem: When you try to open the file to install the program, Microsoft Word tells you that “The macros in this project are disabled . . .”

Solution: Microsoft Word’s macro virus protection is enabled or set to a high level of security. To change this:

In Word 2007 (PC):

1. Click the round Office button at the upper left of your Word window.

2. Click “Word Options”.

3. Click the “Trust Center” button on the left.

4. Click the “Trust Center Settings” button on the right.

5. Select “Enable all macros,” which you should change back to your previous setting after the installation is finished.

6. Click the OK button.

7. Click the next OK button to close the Word Options dialog.

In Word 2004 (Macintosh):

1. Click the “Word” menu.

2. Click “Preferences.” 

3. Click “Security.”

4. Uncheck “Warn before opening a file that contains macros.”

5. Click the OK button.

In Word 2002/XP or 2003 (PC):

1. Click the “Tools” menu.

2. Click “Options.”

3. Click the “Security” tab.

4. Click the “Macro Security” button (on the lower right).

5. Click the “Security Level” tab if it’s not already active.

6. Set your security level to medium and click the OK button.

7. Click the next OK button to close the Options dialog.

In Word 2001 (Macintosh):

1. Click the “Edit” menu.

2. Click “Preferences.”

3. Click the “General” tab if it’s not already active.

4. Uncheck “Macro virus protection.”

5. Click the OK button.

In Word 2000 (PC):

1. Click the “Tools” menu.

2. Click “Macro.”

3. Click “Security.”

4. Click the “Security Level” tab if it’s not already active.

5. Set your security level to medium and click the OK button.

In Word 98 (Macintosh):

1. Click the “Tools” menu.

2. Click “Preferences.”

3. Click the “General” tab.

4. Uncheck the box labeled “Macro virus protection.”

5. Click the “OK” button.

In Word 97 (PC):

1. Click the “Tools” menu.

2. Click “Options”.

3. Click the “General” tab.

4. Uncheck the box labeled “Macro virus protection.”

5. Click the “OK” button.

After installing the program, you may want to reset your security settings to their previous state. If you don’t (in Word 2000 through 2003 on PC), any time you open a document or template that includes macros, Word will give you the choice of whether to disable or enable macros. If the document or template isn’t supposed to have macros in it, you should click the “Disable Macros” button, because the macros could be a virus. If the document or template is supposed to have macros and comes from a source you know is reliable, click the “Enable Macros” button so you can run the macros.

In other versions of Word, you don’t have these options. Macro virus protection is either on or off. Before turning it off permanently you may want to read more about it in Word’s Help file or check with your system administrator.

If you need more help, please send an email message to support@editorium.com.

Problem: RazzmaTag won’t work at all, even though you’ve loaded it as a global template.

Solution: You may see this problem if you’re working on documents that have been created in other word-processing programs, such as WordPerfect, and then opened into Microsoft Word. If that’s the case, you may be able to save the documents from the other program into Microsoft Word format before opening them into Word. You may also need to use a dedicated document-conversion program.

Problem: You’re tagging documents and saving as text, but RazzmaTag keeps saying that you appear to be untagging documents and asking if you really want to save as text. What’s going on?

Solution: Somewhere in your master list is an incorrect RazzmaTag code. For example, the code for tagging a paragraph style is +P. But your list may have +p (lowercased) somewhere instead.

If you’re purposely tagging and untagging at the same time (which is possible but not recommended), you’ll also see this warning.
Problem: You’re untagging files and saving as Word documents, but RazzmaTag keeps saying that you appear to be tagging documents and asking if you really want to save as Word documents.

Solution: Somewhere in your master list is an incorrect RazzmaTag code. For example, the code for untagging a paragraph style is +p. But your list may have +P (uppercased) somewhere instead.

If you’re purposely tagging and untagging at the same time (which is possible but not recommended), you’ll also see this warning.
Problem: You just untagged a document, and now it’s full of red and blue formatting.

Solution: If you’re untagging a text file, your custom paragraph and character styles won’t even exist in the document (since it’s a text file). So how is RazzmaTag supposed to replace your tags with your custom styles? There’s only one way it can—by creating those styles. Of course, RazzmaTag has no idea how those styles should be formatted, so it formats paragraph styles as red and character styles as blue, just so you can spot the newly formatted text easily. Next, of course, you’ll want to modify the styles or apply a different template to the document (being sure to update styles) so the formatting will look the way you want it to.

Problem: You want to tag or untag documents, but they’re just not turning out right. The formatting is wrong, or the tags are messed up.

Solution: If you start having trouble with stuff like this, slow down. Don’t panic and wildly start trying to fix entries on your list. Instead, try processing your entries one at a time, or better yet, try searching for an entry manually in Word so you can see what’s actually happening. For example, if you have an entry like this on your master list—

Heading 1|<Chapter Title>+P

—you can try doing the same thing manually to see what that entry does. In this case, after clicking Edit > Replace, you’d select the style formatting for Heading 1 in the “Find What” box, otherwise leaving the box empty. (You may need to click the “More” button before this option is available.) (Make sure you don’t type “Heading 1” into the box. You’re trying to find formatting, not the words “Heading 1.”) Then, in the “Replace With” box, enter the text “<Chapter Title>” (without the quotation marks) and select the format of Normal style. Click the Find button to find the first instance of Heading 1 formatting in your document. Then click the Replace button to make the change. Now look at the change in your document. Is it what you wanted? If not, you’ll need to adjust your entry.

Here’s an example of untagging:

\<Chapter Title\>(*)|Heading 1+p

In this case, you’d put “\<Chapter Title\>” in the “Find What” box. Then you’d format the “Replace With” box as Heading 1. Next, put “\1” in the “Replace With” box, telling Word to replace the text “\<Chapter Title\>” with the text found by (*) which would be no text at all. Finally, put a check in the box labeled “Use Wildcards” or “Use Pattern Matching.” Then click the Find button and the Replace button to see what’s going on. (For more information about these arcane symbols and how they work, see the document “Advanced Searching in Microsoft Word” that came with RazzmaTag.)

With this kind of line-by-line experimentation, you’ll soon learn what’s causing the problem.

Problem: RazzmaTag isn’t making some of the changes you specified.

Solution: RazzmaTag can’t make any changes you couldn’t make manually with Word’s Find and Replace features. Please read “Using Word’s Find Options” in this documentation for more information. Also, some documents originally created in WordPerfect don’t work well with Find and Replace in Microsoft Word. You can check this yourself by trying the Find and Replace manually. Finally, you may have forgotten to add the codes at the ends of your master-list entries. Those codes are:

+P = tag paragraph style formatting

+A = tag character style formatting

+F = tag character formatting (such as bold or italic)

+p = untag paragraph style formatting

+a = untag character style formatting

+f = untag character formatting (such as bold or italic)

Without the codes, RazzmaTag won’t know what to do and will essentially ignore your entries.

Problem: RazzmaTag has been running for hours while working on just a few short documents.

Solution: Press the Escape key to stop the program. Look at the cursor position in the open document to see if you can figure out what may be causing the problem. If you can, fix the problem before running RazzmaTag again. Also, check the documents after the problem document to see if they have the same problem. If you’ve used revision marking in the document, you may need to make revisions permanent before proceeding. You may also have problems if you’re working on documents that have been created in other word-processing programs, such as WordPerfect, and then opened into Microsoft Word. If that’s the case, you may be able to save the documents from the other program into Microsoft Word format before opening them into Word. You may also need to use a dedicated document-conversion program.

Problem: You get an error message while running RazzmaTag.

Solution: You may be trying to work on a document that is read-only, password-protected, or needs to be converted from another word-processing format. Try opening the document into Word without using RazzmaTag. If you get an error message, you’ll need to fix the document or problem before using RazzmaTag. Also, make sure all of Word’s import filters have been installed. Otherwise, Word won’t be able to open documents from other word processors and will give you an error message if you try to open them, with or without RazzmaTag.

Problem: Microsoft Word crashes at some point when you’re using RazzmaTag.

Solution: Some of your documents may be corrupt. You can identify a document that caused the crash by reading its name in the bar at the top of the Word window when the program crashes. If possible, open the document, copy all of its text but the final paragraph mark, and paste the text into a new document.

Any Questions?

We hope you find RazzmaTag to be immensely useful. If you have any questions or comments, please let us know.

support@editorium.com

www.editorium.com

The Editorium provides word-processing tools for editors, writers, and other publishing professionals. If you like RazzmaTag, you may be interested in these other products from the Editorium:

Editor’s ToolKit Plus includes Editor’s ToolKit, FileCleaner, NoteStripper, and QuarkConverter.

Editor’s ToolKit provides powerful tools for copyediting in Microsoft Word.

QuarkConverter converts Word documents into XPressTag files for import into QuarkXPress.

NoteStripper strips footnotes and endnotes to the end of a document as numbered text.

FileCleaner cleans up common editorial and typographical problems in electronic manuscripts.

You can download fully functioning evaluation copies of these programs free of charge from the Editorium’s site on the World Wide Web at www.editorium.com.

This documentation and the RazzmaTag software are copyright © 1996, 2000, 2001 by the Editorium. All rights are reserved. Editor’s ToolKit Plus, Editor’s ToolKit, NoteStripper, MegaReplacer, RazzmaTag, FileCleaner, and Editorium are trademarks of the Editorium.

All trademarks mentioned in this documentation or the program are acknowledged as trademarks of their owners.

Terms of Agreement

By using RazzmaTag, you agree to these terms:

LICENSE AGREEMENT

The RazzmaTag software and its documentation (collectively the Software) are protected by the United States copyright laws and international treaties and are owned solely and entirely by the Editorium.

You (the licensee) may run the Software on up to three computers (but only on one at a time) during its evaluation period and (if you purchase a license to do so) after that. You may not copy or sell the Software for commercial gain.

You may freely transfer copies of the Software to others for evaluation. You may NOT let someone else use your password for the Software or rent or lease your license to run it, but you may transfer the license to someone else who accepts this agreement.

You may not modify, reverse engineer, decompile, disassemble, unencrypt, or create derivative works from the Software. You may not use the Software in any manner that infringes the intellectual property or other rights of another party.

DISCLAIMER OF WARRANTY AND LIABILITY

The Editorium disclaims all warranties on the Software, expressed or implied, including but not limited to warranties of merchantability and fitness for any particular application, use, or purpose. You use it at your own risk.
Under no circumstances, including its own negligence, shall the Editorium or its suppliers be liable for any special, incidental, or consequential damages or loss that result from the use of, or the inability to use, the Software.

This agreement shall be construed, interpreted, and governed by the laws of the State of Utah in the United States of America.
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